The Diploma in Panchayat Level Development and Administration was sponsored under IGNOU-MOPR-UNDP Project on “Capacity Building of PRIs through a Multi-Mode Training Intervention” and developed under the School of Continuing Education (SOCE) of the Indira Gandhi National Open University. The School of Continuing Education gratefully acknowledges sponsorship of this Diploma by the United Nations Development Programme (UNDP), India.

“Education is a liberating force, and in our age it is also a democratising force, cutting across the barriers of caste and class, smoothing out inequalities imposed by birth and other circumstances.”

-Indira Gandhi
### BASIC APPLICATIONS OF COMPUTERS

<table>
<thead>
<tr>
<th>Block</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>BASIC APPLICATIONS OF COMPUTERS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>UNIT 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Introduction to MS-Word</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>UNIT 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Introduction to MS-Excel</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>UNIT 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Power Point Presentation</td>
<td>46</td>
</tr>
</tbody>
</table>
BLOCK 2: BASIC APPLICATIONS OF COMPUTERS

Block Introduction

'Basic Applications of Computers' is the second block of Course-5 on 'Basic Computer Literacy'. It covers all the basic components of MS Word, MS Excel and MS PowerPoint, and the learners are introduced to working with Microsoft Office tools. This block consists of three units. **Unit 1** covers Microsoft Word also known as MS-Word which was developed by Microsoft. It is a powerful word processing tool to create word documents. It is commonly used to create letters, memos, reports, term papers etc. **Unit 2** covers Microsoft Excel, also known as MS Excel developed by Microsoft. Microsoft has introduced MS Excel in Microsoft Office Program along with other application programs. It is a powerful tool to create electronic spreadsheets. Spreadsheet is a generic term of the software package that simulates a paper worksheet. A variety of applications for which MS Excel can be used include financial statements, business forecasts, transaction register, inventory control, accounts receivable and accounts payable. One can also create graphs and charts based on data for quick understanding of a problem. Excel can create formulas by using row and column headers instead of range references. **Unit 3** of this block deals with Microsoft PowerPoint, which is commonly used nowadays for delivering lectures or making presentations in seminars and conferences. It is a software product of Microsoft office and one can make computer-based presentations using animations, graphics and sound.

We hope that you will enjoy going through this block and also in answering text questions and attempting lab exercises.
UNIT 1  INTRODUCTION TO MS-WORD

Structure

1.0 Objectives
1.1 Introduction
1.2 Starting MS-Word
1.3 Document Window
1.4 Components of Document Window
  1.4.1 Title Bar
  1.4.2 Menu Bar
  1.4.3 Ruler Bar
  1.4.4 Status Bar
  1.4.5 Workspace
  1.4.6 Toolbar
    1.4.6.1 Standard Toolbar
    1.4.6.2 Formatting Toolbar
1.5 Creating Documents
1.6 Opening Documents
1.7 Saving Documents
1.8 Printing Documents
1.9 Formatting Text
  1.9.1 Changing Fonts and Font Styles
  1.9.2 Changing Font Size
1.10 Formatting Paragraph
  1.10.1 Line Spacing
  1.10.2 Paragraph Spacing
  1.10.3 Indenting Text
  1.10.4 Aligning Text
  1.10.5 Adding Numbers and Bullets
1.11 Some Advanced Features
  1.11.1 Find and Replace Option
  1.11.2 Inserting a Table
  1.11.3 Inserting a Picture
  1.11.4 Spell Checker
1.12 Let Us Sum Up

1.13 References and Suggested Readings
1.14 Check Your Progress – Possible Solutions/Answers

1.0 OBJECTIVES

After going through the Unit, you will be able to:

- Open MS-Word;
Basic Applications of Computers

- Create Word Documents;
- Save documents;
- Format text, paragraph;
- View an existing document;
- Check spellings;
- Insert pictures;
- Find the mistakes and also replace it; and
- Print your document.

**Did you know?**

Word Processor is software that is used to create, edit and format any document.

1.1 INTRODUCTION

Microsoft word also known as MS-Word was developed by Microsoft. Microsoft introduced MS-Word in Microsoft Office Package along with other application programs. Microsoft Word is a powerful word processing tool to create word documents. MS Word lets you create letters, memos, reports, term papers professional documents like resume writing, application forms, office letter etc. You can create document, store it for future use and take a print. Once you have created a document, it is also important to know how to format it. Formatting includes assigning fonts and font size, aligning text and many more. You can insert hyperlink, pictures and tables etc to make it more attractive. When you are writing something, no matter how careful you are, mistakes are likely to happen. Most of the errors are wrong spellings. For this you need a spell checker to check out errors.

1.2 STARTING MS-WORD

Microsoft Word is a word processor. It helps us to create professional letters, memos, reports, term papers. We can also edit existing document, take a print of whole document, send it through mail, and format documents according to our need.

There are two ways to open MS-Word:

1. Double click on the Microsoft Word icon on the desktop.

Or
2. Click on Start -> All Programs -> Microsoft Office -> Microsoft Office Word

![Menu showing Microsoft Office applications](image)

Figure 1.1: Way to open MS Word through Programs

1.3 DOCUMENT WINDOW

A new document window appears on your screen when you start MS-Word. This is the document window as shown in Figure 1.2. The document window contains individual Word files.

![Grass and document](image)

Figure 1.2: MS Word Window

---

1. The Gram Sabha desired to have a meeting with all the villagers on Wednesday, 31 December, 2008, at 1.00 pm in the Gram Sabha center, Firozpur, UP to interact regarding the general problem of the village. All the villagers shall make it convenient to attend the Sabha.

Date: 31 December, 2008

Circular

Ch. Braham Prakash

Sirpach
1.4 COMPONENTS OF DOCUMENT WINDOW

There are many components of Document Window. Some of these are as under:

- Title bar
- Menu bar
- Toolbar
- Ruler
- Workspace
- Status bar

1.4.1 Title Bar

Title Bar displays a number of items about the currently active document.

![Figure 1.3: Title Bar](image)

The Title Bar contains following information about document:

- Name of the Program (document title)
- Control menu icon
- Minimize button
- Maximize button
- Restore button
- Close button

1.4.2 Menu Bar

It is positioned below the Title Bar. The menu bar provides functionality from opening of file to formatting of files. You can mail your document, choose styling of text, insert a picture, save your document etc.

![Figure 1.4: Menu Bar](image)

The Menu Bar contains nine options:

- File
- Edit
- View
- Insert
- Format
- Tools
- Table
- Window
- Help
Each of these menu bar items has drop-down menus.

1.4.3 Ruler Bar

Ruler bar allows you to format the vertical alignment of text in a document. It is also used to set tab settings on a line of text.

![Figure 1.5: Ruler Bar](image)

You can select the Ruler option from the view menu to display or hide the ruler bar.

1.4.4 Status Bar

Status bar shows the information about the current document on which you are working. This includes:

- Page number
- Column and line number
- It shows five labels- REC, MRK, EXT, OVR and WPH:

1.4.5 Workspace

Workspace is the area in the document window where you enter the text.

![Figure 1.7: Workspace](image)

In Work area you enter all the details and information. You can also do formatting of your text according to your need.

1.4.6 Toolbar

Toolbar containing buttons, drop-down menus and other controls. These are just the shortcuts to the menu items in the Menu bar.
Word provides 16 toolbars that help you to perform tasks faster and with ease. The most commonly used toolbars are:

- Standard toolbar
- Formatting toolbar

### 1.4.6.1 Standard Toolbar

The standard toolbar is below the Menu bar. Standard toolbar provides shortcuts for menu items. The left of the toolbar enables you to perform tasks common to many windows-based programs, such as opening a new file or existing file, saving or printing files, cutting and pasting of text, and undoing and redoing the most recent actions. The right of the standard toolbar offers some functions more specific to word application.

**Figure 1.8: Standard Toolbar**

The standard toolbar contains following buttons explained below:

- **New Blank document**: Opens a new Word document.
- **Open**: Opens an existing saved Word document.
- **Save**: Saves the current document.
- **E-mail**: Sends the contents of the document as the body of the e-mail message.
- **Print**: Opens the print dialog box.
- **Print Preview**: Shows how a file will look when you print it.
- **Spelling and Grammar**: Initiates the spell check functions.
- **Cut**: Places selected text on the Windows Clipboard.
- **Copy**: Places a copy of selected text on the Windows Clipboard.
- **Paste**: Pastes the contents of the Clipboard on the document.
- **Format Painter**: Enables you to copy formatting from one object to another.
- **Undo**: undoes the last action.
- **Redo**: redoes the last undone action.
- **Insert hyperlink**: Inserts a link to a WWW site on the document.
- **Web Toolbar**: displays the Web toolbar.
- **Insert Table**: Inserts a word at the insertion point.
- **Insert Microsoft Excel Worksheet**: Inserts an Excel worksheet with Excel tools available for editing.
- **Tables and Borders**: Inserts a Table and Borders toolbar.
- **Columns**: Changes the number of columns in a document.
- **Drawing**: Displays or hides the Drawing toolbar.
1.4.6.2 Formatting Toolbar

The Formatting Toolbar contains tools that are common to windows programs and related to formatting of text in documents. This includes changing document style, font, font type, color, paragraph alignments, borders etc.

The names and functions in Formatting Toolbar are as follows:

- **Style**: Opens a drop-down list for selection of style.
- **Font**: Opens a drop-down list for selection of font.
- **Font Size**: allows you to enter a new size for the selected text.
- **Bold**: Toggles the text from normal to bold text.
- **Italic**: Toggles the text from normal to italic text.
- **Underline**: Toggles the text from normal to underline text.
- **Shadow**: Applies a shadow effect to the selected text.
- **Left Alignment**: Aligns selected text to the left.
- **Center Alignments**: Aligns selected text to the center.
- **Justify**: Aligns selected text at the left and right margins or indents.
- **Right Alignment**: Aligns selected text to the right.
- **Numbering**: Applies a numbering format to selected text.
- **Bullets**: Applies a bullet list format to selected text.
- **Increase Indent**: Increases indent of selected lines of the text.
- **Decrease Indent**: Decreases indent of selected lines of the text.
- **Outside Border**: Add or Remove a border around the selected text, paragraphs, pictures etc.
- **Highlight**: Marks text so it is highlighted.
- **Font Color**: Formats the selected text with the color you click.

1.5 CREATING DOCUMENTS

MS Word allows you to create any type of document either personal or professional. You can type a document with the help of a keyboard and save it to the hard disk.
of your system. There are following steps to create your own document:

- Select the New option from File Menu of the menu bar.
- A dialog box appears on the right of your screen. It shows different types of document you can create like Blank document, XML document, Web page and E-mail message.
- Click on Blank Document link.
- A new blank document is displayed.

### 1.6 OPENING DOCUMENTS

From this option you can open any existing or previously saved documents for alteration or reading purpose. For this you have to follow these steps:

- Select the Open option from the File menu of the menu bar.
- Select the appropriate drive and folder.
- Double click on the desired filename to open the document.

### 1.7 SAVING DOCUMENTS

You need to store the document you created on the disk so that it is available at later stage. For this follow these steps:

- Select the Save option from the File menu of the menu bar.
- Enter a filename in the File name box and click on the Save button.

By default, the new document is saved as Word document with the extension “.doc”.
1.8 PRINTING DOCUMENTS

MS Word allows you to take print of your document. MS Word has an option to set up your print properties and layouts before printing the documents. Before taking print be sure you are connected with printer otherwise it can not help you to print your document. For this you have to follow these steps:

- Select Print Preview to check the layout of your document is appropriate or not. Otherwise, select Print from File menu of the menu bar.

- A Print dialog box appears. Set all the parameter like number of copies, take print from current page. You can specify page number too.

- Finally click on Print button.

Check Your Progress I

Note: a) Write your answer in the space provided.

b) Check your answer with the possible answer provided at the end of the unit.

1) What is the purpose of MS-Word?

2) Explain what are the basic components of a toolbar.

3) What is Print Preview?

1.9 FORMATTING TEXT

As discussed in earlier section, menu options and toolbar buttons are used to format documents. Formatting a document involved assigning fonts and font sizes, aligning text, paragraph spacing and setting margins.
1.9.1 Changing Fonts and Font Styles

Fonts refer to the manner or style in which text is displayed in the document. Different fonts contain different symbols and characters. Word offers a large number of fonts and font styles like Arial, Impact, Times New Roman, etc. First, you have to select the text that you want to be formatted. Follow these steps to change fonts and font styles:

Click on the Format toolbar, a drop-down list appears on your window. Type the name of the desired font directly or select an option from the drop-down list and press Enter key.

Use Bold (B), Italics (I), Underline (U) buttons on the Format toolbar. To add bold formatting to the text, follow these steps:

Select the text and click on the bold button.

Alternatively, click on the bold button and type the text. Similarly, you can select Italic and Underline button.

1.9.2 Changing Font Size

Font size is measured in points. Points and picas are used for measuring spacing, lines, and thickness and so on. There are 12 points to a pica and six picas to an inch; therefore, there are 72 points to an inch. To change font size, follow these steps:

Use the drop-down list of Font Size on the formatting toolbar. Type the font size or select a font size from drop-down list and press Enter key.

Alternatively, you can use the Font dialog box to change font size, fonts, and font styles.
Alternatively you stylu.

Figure 1.12: Font dialog box

Select the font option from Format menu. A font dialog box gets invoked as displaying in figure.

Select any option from the Font tab. You can apply one or more of these styles to the selected text.

1.10 FORMATTING PARAGRAPH

In Word, whenever you press the Enter key, you create a new paragraph. Word paragraph always ends with a paragraph mark. When you open a new document, the default paragraph setting stored as a style is applied. You can press ‘Shift+Enter’ combination keys to force new lines without a new paragraph.

1.10.1 Line Spacing

Spacing is used to design your document and make it more readable. The default setting of spacing is single. Word enables you to change the line spacing in your text. You can set spacing to single, double or one and half lines. To set the line spacing, follow these steps:

- Select the paragraph option on the Format menu. The paragraph dialog box gets invoked as displayed in the figure.
Basic Applications of Computers

Figure 1.13: Paragraph dialog box

- Select the Indents and spacing tab
- Select an option from the Line spacing drop-down list.
- Select the value from the list box.
- Click on the OK button to close the dialog box

1.10.2 Paragraph Spacing

You can define white space placed before and after paragraphs by giving values in the spacing area of paragraph dialog box.

1.10.3 Indenting Text

Indents are added to margins thereby increasing the white space and decreasing the text area for specific paragraphs. To set the Indents for text by using paragraph dialog box:

- Enter the specification for left, right and first line indents in the indentation area of paragraph dialog box.
- Select an option from the drop-down list.
- Click on the OK button.

1.10.4 Aligning Text

Alignment is the way of organizing the text. It refers to the position of the text relative to margins. It enables you to left-align, right-align, center-align and justify the text in your document. Word default alignment is left alignment.
'Basic Applications of Computers' is the second block of Course-5 on 'Basic Computer Literacy'. It covers all the basic components of MS Word, MS Excel and MS PowerPoint, and the learners are introduced to working with Microsoft Office tools. This block consists of three units.

---

**Figure 1.14: Alignment of Text**

- **Right-Aligned Text**: text is said to be right-aligned if it is aligned with the right margin of the page.
- **Left-Aligned Text**: Text is said to be left-aligned if it is aligned with the left margin of the page.
- **Center-Aligned Text**: Text is said to be center-aligned if it is aligned to the center of the page.
- **Justified**: This feature aligns a paragraph both from the left and the right margins.

### 1.10.5 Adding Numbers and Bullets

Numbers and Bullets are used to index the highlighted portion of the text. You can use bullets and numbers to make the lists and it is easy to read. For this you have to follow these steps:

- Select the text before adding Bullets and Numbers.
- Select the 'Bullets and Numbering options of the format menu. The Bullets and Numbering dialog box gets invoked.
- Click on the Bulleted tab in the Bullet and Numbering dialog box.
- Click to select a style of your choice.
- Click on OK button.

### 1.11 SOME ADVANCED FEATURES

Word provides a number of advanced features for your document. So, it can be very easy for a user to make document in MS Word. But we would discuss only few features here like spell checking, table, picture insertion, and find and replace option.
1.11.1 Find and Replace Option

You can search for text, special character and other document items. You can also replace the searched items with a specified item.

For Find Text:
- Select the Find option from the Edit button of menu bar. The Find and Replace dialog box gets invoked.
- Enter the text in the Find of the dialog box.
- Click on the Find Next option of the Find dialog box to find the position of the text being searched.

![Find and Replace Option](image)

Figure 1.15: Find and Replace Option

For Replacing Text:
- Select the Replace option from the Edit button of the menu bar. The Find and Replace dialog box gets invoked.
- Select the Replace tab.
- Enter the text to be replaced in the Find What box of the dialog box.
- Enter the text to be replaced with in the Replace with text box.
- Click on the Find Next button of the Find dialog box to start the search.
- Click on the replace button to replace the highlighted text with new text in the Replace with box.

1.11.2 Inserting a Table

You can also include table for better display of the text. By this option you can create multiple tables in one document. As per your need you can select numbers of rows and columns.
Figure 1.16: Showing Table with 4 rows and 4 columns

For this, follow these steps:

- Click where you want to add your table.
- Click on the Table from the menu bar.
- Select Insert.
- Select Table.
- Enter number of rows and columns according to your need.
- Click on the OK button.

1.11.3 Inserting a Picture

You can add a picture from the Clip-Art gallery or you can put a picture from the drives. Word facilitates you to design your document through this enabling feature:

- Click where you want add your picture.
- Click Insert from the menu bar.
- Select Picture.
- Select Clip Art or From File.
- Select picture and click Insert.
- Select an appropriate picture from gallery or drives.
- Click on the OK button.

1.11.4 Spell Checker

Word provides this facility so that you can identify or rectify your spelling mistakes.
Automatic spell checker is probably the safest and the quickest way to find whether your spellings are correct. By default, word’s automatic checker is active. If you want to check errors manually, point to it and right click on it.

**Figure 1.17: Options dialog box**

To turn off the automatic spell check, the steps are:
- Select the Options option from the Tools menu. An Options dialog box gets invoked as displayed in Figure 1.17.
- Select Spelling and Grammar tab and disable the check spelling as you type option.
- Click on the OK button.

To spell check a document by using Spelling and Grammar dialog box, follow these steps:
- Select the Spelling grammar option from the tools menu and press f7. A spelling and Grammar dialog box gets invoked.
- Select text of the document for spell check
- Click on the Ignore button to ignore the misspelled word.
- Click on the Change button to replace the misspelled word displayed in Not in dictionary box.

**Check Your Progress II**

*Note:* 

*a*) Write your answer in the space provided.

*b*) Check your answer with the possible answer provided at the end of the unit.

1) How can you turn off the automatic spell check?
2) What is the purpose of spell checker in MSWord? Write down the steps for checking your document using spell checker.

3) Write down the steps to create a new word document and save it in your hard disk.
1.12 LET US SUM UP

Let us recapitulate what we have learnt so far in this unit

- Microsoft Word is a word processor. It helps you create letters, memos, reports, term papers etc.
- Document Window contains Title bar, Menu bar, Toolbar, Ruler, Workspace and Status bar.
- The various components of a Title bar are title, minimize, maximize, close and control menu.
- The various components of Menu bar are File, Edit, View, Insert, Format, Tools, Table, Window and Help.
- There are two type of Toolbar: Standard and Formatting toolbar.
- Print Preview enables you to view either a full readable page or an unreadable view of page depending on screen size.
- The different types of alignments are right, left, centre and justified.
- Left is default alignment for MS Word.
- Word provides facilities to find some specific words and replace it with the help of Find and Replace Options.
- Word document also includes table for better display of the text. By this option one can create multiple tables in a document.
- Insert pictures option helps in displaying images on document.
- Word provides facility to identify or rectify your spelling mistakes.
- Automatic spell checker is probably the safest and the quickest way to find out incorrect spellings.

1.13 REFERENCES AND SUGGESTED READINGS

- Understanding Computer Applications, "IGNOU Course Material MFN-010.
- www.nos.org/htm/funda2.htm

1.14 CHECK YOUR PROGRESS - POSSIBLE SOLUTIONS/ANSWERS

Check Your Progress 1

1) Microsoft Word is a powerful word processing tool to create word documents. The purpose of MS-Word is used to create professional documents like resume writing, application forms, office letters, reports etc.

2) Toolbar contains buttons, drop-down menus and other controls. The most commonly used toolbars are standard toolbar and formatting toolbar,

- **Standard Toolbar**: The standard toolbar is below the Menu bar. Standard toolbar provides shortcuts for menu items. The toolbar enables you to perform tasks common to many windows-based programs, such as opening
a new file or existing file, saving or printing files, cutting and pasting of text, and undoing and redoing the most recent actions.

- **Formatting Toolbar**: The Formatting Toolbar contains tools that are common to Windows programs and related to formatting of text in documents. This includes changing document style, font, font type, color, paragraph alignments, borders, etc.

3) MS Word allows you to take print of your document. Print Preview is used to check the layout of your document is appropriate or not.

### Check Your Progress II

1) To turn off the automatic spell check, you have to follow these:

- Select the Options option from the Tools menu. An Options dialog box gets invoked.
- Select Spelling and Grammar and disable the check spelling as you type option.
- Click on the OK button.

2) Word provides this facility so you can identify or rectify your spelling mistakes. Automatic spell checker is probably the safest and the quickest way to find that your spellings are correct. To spell check a document by using Spelling and Grammar dialog box, follow these steps:

- Select the Spelling grammar option from the tools menu and press F7. A spelling and Grammar dialog box gets invoked.
- Select text of the document for spell check
- Click on the Ignore button to ignore the misspelled word.
- Click on the Change button to replace the misspelled word displayed in Not in dictionary box.

3) MS Word allows you to create any type of document either personal or professional. You can type a document with the help of a keyboard and save it to the hard disk of your system. There are following steps to create your own document.

- Select the New option from File Menu of the menu bar.
- A dialog box appears on the right of your screen. It shows different types of document you can create like Blank document, XML document, Web page and E-mail message.
- Click on Blank Document link.
- A new blank document is displayed.

You need to store the document you created on the disk so that it is available at later stage. For this you followed these steps:

- Select the Save option from the File menu of the menu bar.
- Enter a filename in the File name box and click on the Save button.
Lab exercise:

*Note:*  
*a) Write your answer in the space provided at the end of this unit.*  
*b) For practical purpose attend practical lab.*

1) Prepare a document with proper formatting and try to take a print of this document.  
2) Make a list of all students enrolled for the MCA programme in 2008 by using Bullets and Numbering.  
3) Create a table of students of BCA with the following headings Enrolment no., Name, Semester, Contact no., and Percentage of marks.

*Space provided for practical work*
UNIT 2  INTRODUCTION TO MS-EXCEL

Structure

2.0 Objectives

2.1 Introduction

2.2 Starting MS-Excel

2.3 Components of Excel Worksheet

2.3.1 Title Bar
2.3.2 Menu Bar
2.3.3 Toolbar

2.3.3.1 Standard Toolbar
2.3.3.2 Formatting Toolbar

2.3.4 Worksheet Window

2.3.5 Formula Bar
2.3.6 Name Box
2.3.7 Worksheets Tab
2.3.8 Scroll and Status Bar

2.4 Opening and Saving Worksheet

2.5 Navigating Worksheet

2.6 Entering Data

2.6.1 Entering Text
2.6.2 Entering Number
2.6.3 Entering Date and Time
2.6.4 Entering Formula

2.7 Excel Functions

2.8 Selecting Cell Range

2.9 Editing Worksheets

2.9.1 Formula Bar Method
2.9.2 Clearing a Cell
2.9.3 Copying Data
2.9.4 Inserting and Deleting Row, Column and Cell Range
2.9.5 Naming the Sheets

2.10 Worksheets Formatting

2.10.1 Numeric Formatting
2.10.2 Date and Time Formatting

2.11 Printing Worksheets

2.12 Entering Formulas

2.13 Entering Functions

2.14 Let Us Sum Up

2.15 References and Suggested Readings

2.16 Check Your Progress – Possible Solutions/Answers
2.0 OBJECTIVES

After going through the unit, you will be able to:

- Open MS Excel;
- Understand the features of Excel;
- Save and edit sheets;
- Navigate worksheets;
- Make different types of entries in worksheets;
- Format worksheets;
- Use formula, function; and
- Print your worksheets.

2.1 INTRODUCTION

Microsoft Excel is also known as MS Excel was developed by Microsoft. Microsoft introduced MS Excel in Microsoft Office Program along with other application programs. It is a powerful tool to create electronic spreadsheets. Spreadsheet is a generic term of the software package that simulates a paper worksheet. A variety of applications for which MS Excel can be used include financial statements, business forecasts, transaction register, inventory control accounts receivable and accounts payable. We can also edit existing spreadsheet, take a print of whole spreadsheets, send it through mail, and format all the spreadsheets according to the need. MS Excel provides statistical, analytical, and scientific functions. Data stored in database formats can be accessed through MS Excel. You can also create graphs and charts based on data for quick understanding of a problem. Excel can create formulas by using row and column headers instead of range references. This feature is known as the natural language formula. We shall learn about all of these features of Excel in detail from this unit.

2.2 STARTING MS-EXCEL

There are two ways to open MS-Excel:

Double click on the Microsoft Excel icon on the desktop.

Click on Start->All Programs->Microsoft Office->Microsoft Office Excel 2003, (Figure 2.1).
Figure 2.1: Way to open MS Excel through Programs

When you start Excel, a workbook is displayed. Excel stores all its data and allows manipulation in the workbook. A workbook is a collection of individual worksheets, each of which contains data. All actions and operations take place in the worksheet. Excel has 65536 rows and 256 columns in its worksheets.

Each worksheet (Figure 2.2) is made up of cells. Cell is the basic unit for storing data. Cells are made by intersection of rows and columns. Each cell gets its name from this intersection. The address of a cell in column A that has its row number as 7 is referred as cell A7. A group of contiguous cells is called a range. An example of a cell range would be F1:F3. Cell A1, A2 contains the label Hemant Rana, Rajeev. Cells C7, D7 and F7 contain the values 500, 600 and 800 respectively.
Figure 2.2: MS Excel Worksheet

You can make a cell active by clicking on it. Files created by a spreadsheet package are known as worksheets. Automatic calculation features make the calculation tasks easy. If data in cell is changed then the formula in cell would calculate the result based on the cell content. This is due to fact that, once the formula is created with cell references in it, it establishes a relation with the cell.

2.3 COMPONENTS OF EXCEL WORKSHEET

There are many components of Document Window (Figure 2.3). Some of these are as under:

- Title Bar
- Menu Bar
- Toolbar
- Worksheet window
- Formula Bar
- Name Bar
- Worksheet Tab
- Scroll Bar
- Status Bar
2.3 Title Bar

The title Bar displays a number of items about the currently active worksheet. It appears at the top of all Windows programs. By default, Excel opens with Book 1.

Figure 2.4: Title Bar

The Title Bar contains following information about document:

- Name of the Program (Workbook title)
- Control menu icon
- Minimize button
- Maximize button
- Restore button
- Close button

2.3.2 Menu Bar

It is directly positioned below the Title Bar and displays the list of the menu you can use to give commands to Excel. By clicking on a menu toolbar (Figure 2.5) a drop down menu of command is displayed. You can move across the menu bar and down
the drop-down menus with your mouse by highlighting one of the menu items and using the arrow keys on your keyboard. You can mail your document, use styling of text, insert charts and graphs, save your workbook, and create functions and formula etc.

![Menu Bar](image)

**Figure 2.5: Menu Bar**

The Menu Bar contains nine options:

- **File** - Commands to open, save, close, print, and create new files.
- **Edit** - Commands to copy, cut, paste, find, and replace text.
- **View** - Commands to change how the workbook is displayed on the screen.
- **Insert** - Lists items that you can insert into a workbook, such as graphics and charts.
- **Format** - Commands to format fonts, cell alignment, and borders.
- **Tools** - Lists tools such as the spell checker and macros.
- **Data** - Commands to analyze and work with data information.
- **Window** - Commands to display and arrange multiple windows.
- **Help** - Get help on using the Excel program File.

Each of these menu bar items has drop-down menus.

### 2.3.3 Toolbar

The toolbar contains buttons, drop-down menus and other controls. These are just the shortcuts to the menu items in the Menu bar.

The most commonly used toolbars are:

- **Standard toolbar**
- **Formatting toolbar**

#### 2.3.3.1 Standard Toolbar

The standard toolbar (Figure 2.6) is below the Menu bar. Standard toolbar provides shortcuts for menu items. The left of the toolbar enables you to perform tasks common to many windows-based programs, such as opening a new file or existing file, saving or printing files, cutting and pasting of text, and undoing and redoing the most recent actions. The right of the standard toolbar offers some functions more specific to Excel application.

![Standard Toolbar](image)

**Figure 2.6: Standard Toolbar**

The tools found on the Standard Toolbar include the following:

- **New** - Creates a new, blank spreadsheet.
- **Open** - Open a previously saved spreadsheet.
• **Save** - Saves your current spreadsheet.

• **Permission** - To restrict access to your spreadsheet.

• **Print** - Prints the current document.

• **Print Preview** - Previews the current spreadsheet to see how it will print.

• **Spelling** - Performs a spell check of cells in the current document.

• **Research** - Enables information rights management which can help protect sensitive documents from being copied or forwarded.

• **Copy** - Copies the current selection to the clipboard, which can then be pasted elsewhere in the document.

• **Paste** - Takes the current clipboard contents and inserts them.

• **Undo** - Undoes the last action in the document.

• **Redo** - Redoes the last undone action.

• **Insert Hyperlink** - Inserts a hyperlink to an Internet Web location.

• **Auto Sum** - A drop-down menu of available mathematical operations to perform.

• **Sort Ascending** - Sorts the current selection in ascending order.

• **Chart Wizard** - Opens the “Chart Wizard,” by which you can create charts and diagrams using the selected data.

• **Other Options** - There are a variety of other options you can add to the toolbar, such as Cut, Email, Sort Descending, etc.

### 2.3.3.2 Formatting Toolbar

The Formatting Toolbar (Figure 2.7) contains tools that are common to windows programs and related to formatting of text in Excel. This includes changing style, font, font type, color, paragraph alignments, borders etc.

![Figure 2.7: Formatting Toolbar](image)

The Formatting Toolbar includes commonly used buttons for formatting the information in cells. These include the following:

• **Font** - Changes the font of the selected cells.

• **Size** - Changes the font size of the selection.

• **Bold** - Puts the selection in bold face.

• **Italics** - Puts the selection in italics.

• **Underline** - Places an underline beneath the selection.

• **Align Left** - Aligns the current selection to the left.

• **Align Right** - Aligns the current selection to the right.

• **Merge & Center** - Combines two selected cells into one new cell that spans the width of both and center the contents of this new cell.
Basic Applications of Computers

- **Currency Style** - Changes the style in which currency is displayed.
- **Percent Style** - Changes the style in which percent is displayed.
- **Decrease Indent** - Decreases the indent of a cell by approximately one character.
- **Border** - Adds or alters the style of borders around selected cells.
- **Fill Color** - Selects a color to fill the background of a cell.
- **Font Color** - Selects a color to apply to a selection of text.

### 2.3.4 Worksheet Window

You can have multiple worksheets in an Excel file. The worksheet window (Figure 2.8) is where you enter data into the cells on the worksheet. You can have more than one worksheet open at a time. Each worksheet contains columns and rows.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sunday</td>
<td>Monday</td>
<td>Tuesday</td>
<td>Wednesday</td>
<td>Thursday</td>
<td>Friday</td>
<td>Saturday</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Figure 2.8: Worksheet Window*

### 2.3.5 Formula Bar

The Formula Bar allows you to view, enter, and edit data in the selected cell. If the cell contains a formula, it will be displayed here. If there is no formula then the content of the cell is displayed. The cell content can be edited directly in the cells or in the Formula bar (Figure 2.9).

*Figure 2.9: The Formula Bar*
The mathematical formula will appear in the Formula Bar when a cell that includes a formula is selected in the worksheet.

### 2.3.6 Name Box

The Name Box (Figure 2.10) displays the active cell address. For example, the selected cell in the image below is at the intersection of column C and row 1. “C1” will appear in the name box, indicating that the active cell is C1. The content of the selected cell appears in the Formula bar to the right of the Name box.

![Figure 2.10: Name Box](image)

### 2.3.7 Worksheets Tab

You can keep multiple worksheets together in a group called a workbook. For example, you could create a separate worksheet for each day of the month in a workbook for the month January. You can give worksheets names and identify by placing your cursor over the sheet name and typing. By default, Excel opens with three worksheets.

![Figure 2.11: Worksheets Tab](image)

### 2.3.8 Scroll and Status Bar

**Scroll Bars** - Horizontal and Vertical scroll bars are available to help you move around your spreadsheet.

**Status Bar** - If the Status bar is on, it will appear at the bottom of the screen. It displays messages and feedback. You should see the work “Ready” on the Status
Basic Applications of Computers

Bar at the left side of the screen. This tells you that Excel is in Ready mode and waiting for your next command. There are other indicators that appear on the Status Bar in the lower right of the screen.

Figure 2.12: Status Bar

Num Lock Key - The Num Lock key is a toggle key. When you turn it on and off, the Status Bar lets you know the Num Lock key status.

Caps Lock Key - The Caps Lock key is also a toggle key. The Status Bar will also indicate whether it is on or off. When it is on, you will see “CAPS” in the Status Bar.

Check Your Progress I

Note: a) Write your answer in the space provided.

b) Check your answer with the possible answer provided at the end of the unit.

1) What is MS-Excel? What is the purpose of it?

2) What are the basic components of standard toolbars and explain few of them?

2.4 OPENING AND SAVING WORKSHEET

Using this option you can open any existing or previously saved Excel sheet for alteration or reading purpose. For this you have to follow these steps:

- Select the Open option from the File menu of the menu bar.
- Select the appropriate drive and folder.
- Double click on the desired filename to open the document.
You need to store the spreadsheet you created on the disk so that it is available at a later stage. For this follow these steps:

- Select the Save option from the File menu of the menu bar.
- Enter a filename in the File name box, select the location on drive and click on the Save button.

By default, the new document is saved as Excel spreadsheet with the extension "xls".

![Figure 2.13: Saving the Document](image)

2.5 NAVIGATING WORKSHEET

A1 is always the active cell in a new worksheet by default, but if you want to move on to another cell for data entry, then you can make that cell active by three ways:

- Moving the mouse pointer in that cell
- By Clicking the arrow keys of keyboards
- By using Menu Bar

You can use the arrow keys, Page up, page down and a host of other keys in combination to move around in a worksheet.

Through Menu bar, follow these steps:

- Select the Go to option from edit menu or press F5 function key to open up the Go To dialog box and enter the reference of the cell like C1.
- Click on the OK button. The cell pointer moves to cell C1 immediately.
You can also use mouse for moving around on the sheet. First select the cell you want to activate, place the mouse pointer on it and click to activate it.

2.6 ENTERING DATA

Active cell is indicated by a rectangle boundary over that cell. As you type, the data is displayed in the active cell as well as in the formula bar.

| SUM | \( x \times y / z = \) |

Figure 2.14: Entering Data

There are three boxes that exist between the Formula Bar and Name Box.

- The first box with a cross (X) symbol cancels your entry made in the cell.
- The second box with right mark allows acceptance of data in the cell.
- The third box contains an equal to (=) sign. This is the Edit Formula feature that simplifies the calculation tasks.

2.6.1 Entering Text

The text can be numbers, letters or symbols. Numbers can also be treated as text, especially where calculations are not required like phone number, roll number, zip code etc.

2.6.2 Entering Number

Numeric entries are constants and can be integers, decimal, fraction and scientific notations.

2.6.3 Entering Date and Time

Date and Time entries can also be made in the Excel worksheets. Excel allows calculation on dates because it converts date entry to a serial number. For example, you can calculate the age of person by reducing the current date from his date of birth. The valid format for date and time are:

- Valid date format - 6/5/1984, 6-MAY-1985, MAY-6
- Valid time format – 12:55, 12:55:45, 12:45 PM

2.6.4 Entering Formula

Excel uses formulas for calculation. Formulas can be simple and complex. Formulas can also contain named cells or cell ranges. Excel formula functionalities lie in the fact that it can relate the formula to the cell referred in it and, if the contents of these cells change, a new result is calculated automatically from recalculation method. The formula entered in an active cell is also displayed in the formula bar as you enter it. To display the result of the calculated expression in the active cell, press Enter key.

2.7 EXCEL FUNCTIONS

Functions can be used to calculate formulas and expressions in Excel. Functions are predefined formulas that perform calculations by using specified values called arguments. The particular order of arguments is called syntax. For example, the SUM function adds the values are range of cell.
To enter a formula that contains a function, follow these steps:

- Click on the cell in which you want to enter formula
- Click on the edit Formula button in the formula bar to start the formula with the function.
- Click on the down arrow head right next to the Functions box, which includes SUM, MIN, MAX, COUNT etc. functions in drop down list.
- Click on the function you want to add to the formula.
- Enter the arguments for the function.
- After completing the formula, click the Enter key.

### 2.8 SELECTING CELL RANGE

Cell range is required to be selected for calculation. Cells can be selected using keyboard and mouse.

To select a cell range using keyboard, you can do the following:

- Move the cell pointer at the corner of the cell range which you want to select.
- Click on the starting cell of the range.
- Press and hold down the shift key and then press the arrow keys to select the range.

To select a cell range using mouse, you can do the following:

- Click on the corner of the range you want to select.
- Drag the mouse over the range.
- When you reach the end of the range, release the mouse button.

### 2.9 EDITING WORKSHEETS

The data that exists in cells may need some editing. You can edit the contents of the cell by using the formula bar method option as described below:

#### 2.9.1 Formula Bar Method

Select the cell you want to edit.

Click on the formula bar or press the F2 key.

The contents of the cell get displayed in the formula bar which can be edited according to need.

#### 2.9.2 Clearing a Cell

To clear a cell is to erase the cell content but it is not similar to deleting a cell. There are different ways of clearing the cell contents:

- By using Shortcut menu
- By using Delete key
- By using Menu bar
To clear the content of cell by using shortcut menu (Figure 2.15):

- Highlight the cell or range of cells to be cleared.
- Click on the right mouse button. Select the Clear Contents from the shortcut menu.

To clear the cell contents by using the delete key, first select the cell and use delete key to clear a cell. Excel clears all the data from the cell, but does not change the cell formatting.

To clear the cell contents by using Menu bar, follow these steps:

- Select the cell or range of cells.
- Select the Clear option from the Edit menu.

2.9.3 Copying Data

By using copy and paste feature you can create multiple copies of worksheet data. This makes it easier to copy the contents of the cells than typing the data all over again. You can copy the content in two ways:

- Using Menu Bar
- Using Shortcut Menu

By using Menu Bar, you need to follow these steps:

- Select the cell or range of cells that are to be copied.
- Select the copy option from the Edit menu.
- Select the cells in which you want to paste a copy of the data.
- Select the paste option from the Edit menu or press Ctrl+v.
By using Shortcut menu:

- Select the range of data that you want to copy.
- Click on the right mouse button.
- Select Copy from the shortcut menu.
- Select the cells in which you want to paste your data.
- Click on the right mouse button and select paste option.

2.9.4 Inserting and Deleting Rows, Columns and Cell Range

You can insert and delete rows, columns and cell ranges according to your need. The method for insertion / deletion of cell is similar to insertion/deletion of row/column except that a cell is to be selected.

To insert a column using Shortcut menu, the steps are:

- Position the cell pointer in the column where you want your new column should be inserted.
- Click on the right mouse button on the column header and select the insert option from the shortcut menu.

To delete a column using shortcut menu, steps are:

- Select the letter of the column you want to delete.
- Click on the right mouse button.
- Select the delete option from the shortcut menu.

To insert a row using the shortcut menu, steps are:

- Select a cell in the row below where the new row should appear.
- Click the right mouse button on the row header.
- Then select Insert option from the shortcut menu.

To delete a row using shortcut menu, steps are:

- Select the row which you want to delete.
- Click the right mouse button.
- Select Delete option from the shortcut menu.

2.9.5 Naming the Sheets

By default, Excel sheets are referred to as sheet1, sheet 2 and so on. Sheets can be given other names. To name a sheet, Double click the sheet tab to which you want to give a new name. Type a name which you want to give to that sheet. Or you can go to the sheet tab and right click on the tab. Select rename option from shortcut menu. Give an appropriate name to that sheet.

2.10 WORKSHEET FORMATTING

All other Windows based programs like Word, Excel are graphically rich programs, so it has potential of enhancement. By formatting you can display your worksheet with a better look.
2.10.1 Numeric Formatting

The appearance of numeric entries can be changed by using the numeric format functionality offered by Excel. Excel offers various formatting styles and you can also specify your own formatting style. You can format numeric entries by three ways:

- Using Shortcut menu
- Using the Style menu
- Using the Toolbar

But we will discuss only one method here, which is Style menu.

To format the numeric entries using Style menu, follow these steps:

- Select the cells containing numbers you want to format.
- Select the Style option from the Format menu. Style dialog box gets invoked.
- Select the style you want by selecting it from drop down list.
- Select OK option.

2.10.2 Date and Time Formatting

You can change the date and time formats to specify your own. To apply new format, the steps are:

- Select the cell or range containing the data you want to format.
- Select the Cells option from the Format menu.
- Select date from the Category list to display the date format.
- Select the format you want to use from the Type list box.
- Select OK option.

2.11 PRINTING WORKSHEETS

MS Excel allows you to take print of your worksheets. MS Excel has an option to set up your print properties and layouts like fonts, margin etc. before printing the worksheets. Before taking print be sure you are connected with printer otherwise it can’t help you to take print of your worksheet. It enables you to have a preview of worksheets data with Print Preview option.

To printing the worksheets, follow these steps:

- Select Print Preview to check if the layout of your document is appropriate or not. Otherwise, select Print from File menu of the menu bar.
- A Print dialog box will appear. This dialog box is similar to MS Word print dialog box. But it has three extra buttons, which are given below:
  - Selection: print selected cells.
  - Active Sheet(s): printed only selected worksheets.
  - Entire Workbook: prints open workbook.
- Select printer and finally click on Print button.
To print an area, follow these steps:

- Select the range that you want to print.
- Select the Print option from the File menu.
- In the Print What section of the dialog box, choose the Selection option
- Select OK option.

### 2.12 ENTERING FORMULAS

Formulas are used to power the analyzing and creating functioning spreadsheets systems in Excel. Various numeric calculations can be done very easily. You can also manipulate text.

Formulas can be created by following way:

- Select the cell in which you want the formula
- Type the equal to (=) sign to start the formula.
- Click on the cells with the references that are required in the formula.
- Optionally, enter an arithmetic operator.
- Click on the next cell that you want to include in the formula.
- Click on the check box in the formula entry

You can use operators in formulas to add, subtract, multiply, divide eg. +, -, *, / operators respectively. In addition you can use operators for exponent, percentage and comparison in formulas.

### 2.13 ENTERING FUNCTIONS

Excel functions helps in performing simple and complex arithmetic calculations. There are 200 built-in functions or predefined formulas that enable you to create formulas for a wide range of application including business, scientific and engineering applications.

Functions can be entered in the following ways:

- Entering functions manually
- With the help of Insert Function

We will discuss only one method, which is paste function for entering functions.

To enter functions by Insert Function, follow these steps:

- Select the function option from the Insert menu. The Insert Function window is displayed.
- Select the function that is required by clicking on it and click on the OK button. A formula palette drops down which prompts you to enter arguments
- Enter the arguments in the display area or click on the cell reference button to go to the worksheet to select the cells
- Click again on the cell reference button to come back to the same formula palette.
- Click on the OK button.
Check Your Progress II

Note: a) Write your answer in the space provided.
    b) Check your answer with the possible answer provided at the end of the unit.

1) Write the ways to navigate through worksheets.

....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................

2) What is Function? Write down the steps to insert a function in worksheets.

....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................

3) Why do we use Formula in Excel sheet? Write down the steps for including a Formula in Worksheet.

....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
2.14 LET US SUM UP

Let us recapitulate what we have learned so far:

- Microsoft Excel is a Windows-based spreadsheets package.
- Movement in a worksheet is possible by using the keyboard, mouse, or the scroll bars.
- Data entry can be text, date, time and numbers.
- Saving a workbook saves all the worksheets contained in it.
- Worksheets can be inserted and renamed, and deletion is also permitted.
- Copying and moving data from one place to another place in worksheets can be done.
- Numeric formatting features lets you change the appearance of number.
- Charts can be embedded in your worksheets by using chart wizard.
- You can give print command through print option in File menu. You can print workbook as well as selected area of a particular worksheet.
- Formulas are used to power the analyzing and creating functioning spreadsheets systems in Excel.
- Excel functions helps in performing simple and complex arithmetic calculations.

2.15 REFERENCES AND SUGGESTED READINGS

- Understanding Computer Applications, "IGNOU Course Material MFN-010.
- www.nos.org/htm/funda2.htm

2.16 CHECK YOUR PROGRESS – POSSIBLE SOLUTIONS/ANSWERS

Check in Your Progress I

1) Microsoft Excel is an electronic spreadsheet. It helps us to create worksheets which are used mostly in financial and inventory related work. We can also edit existing spreadsheet, take a print of whole spreadsheet, send it through mail and; format all the spreadsheets according to the need.

2) The tools found on the Standard Toolbar include the following:

- **New** - Creates a new, blank spreadsheet
- **Open** - Opens a previously saved spreadsheet
- **Save** - Saves your current spreadsheet
- **Print** - Prints the current document
- **Print Preview** - Preview the current spreadsheet to see how it will print
- **Copy** - Copies the current selection to the clipboard, which can then be pasted elsewhere in the document
Basic Applications of Computers

- **Paste** - Takes the current clipboard contents and inserts them
- **Undo** - Undoes the last action in the document
- **Redo** - Redoes the last undone action

**Check Your Progress II**

1) To navigate in a worksheet, we have the following options:
   - Moving the mouse pointer in that cell
   - By clicking the arrow keys of keyboards
   - By using Menu Bar

2) Excel functions help in performing simple and complex arithmetic calculations. There are 200 built-in functions or predefined formulas that enable you to create formulas for a wide range of applications including business, scientific, and engineering applications.

   To enter functions by Insert Function, follow these steps:
   - Select the function option from the Insert menu. The Insert Function window is displayed.
   - Select the function that is required by clicking on it and click on the OK button. A formula palette drops down which prompts you to enter arguments.
   - Enter the arguments in the display area or click on the cell reference button to go to the worksheet to select the cells.
   - Click again on the cell reference button to come back to the same formula palette.
   - Click on the OK button.

3) Formulas are used to power the analyzing and creating functioning spreadsheets systems in Excel. Various numeric calculations can be done very easily. You can also manipulate text.

   Formulas can be created by following ways:
   - Select the cell in which you want the formula
   - Type the equal to (=) sign to start the formula.
   - Click on the cells with the references that are required in the formula.
   - Optionally, enter an arithmetic operator.
   - Click on the next cell that you want to include in the formula.
   - Click on the check box in the formula entry.

**Lab Exercise:**

**Note:**
- a) Write your answer in the space provided
- b) For practical purpose attend practical lab.
1) Prepare a worksheet with proper formatting and try to take a print of this document.

2) Create a worksheet with 20 rows and following columns:
   - Column A = Roll number
   - Column B = Name
   - Column C = Marks
   - Column D = Percentage

   Calculate the grand total of all students marks.
   Calculate the Average.
   Rename the sheet as Result.
   Cut and Paste the student names, marks in another sheet which should be named as Report.

   **Space provided for practical work**
UNIT 3  POWER POINT PRESENTATION

Structure
3.0  Objectives
3.1  Introduction
3.2  Opening a Power Point
3.3  Elements of Power Point
3.4  Saving and Closing a Presentation
3.5  Inserting Text
3.6  Slide Design
3.7  Adding a New Slide
3.8  Inserting Chart
3.9  Word Art
3.10  Clip Art
3.11  Inserting Tables
3.12  Inserting Animated Images/Movies
3.13  Some keyboard Shortcuts
3.14  Let Us Sum Up
3.15  References and Suggested Readings
3.16  Check Your Progress – Possible Solutions/Answers

3.0  OBJECTIVES

After going through the unit, you will be able to:

- Start and Navigate PowerPoint;
- Create a presentation;
- Work with text in Power Point;
- Work with slide, slide layouts and background colors;
- Create animations in a presentation;
- Insert pictures and images;
- Create charts and diagrams in the presentations; and
- Use keyboard shortcuts for PowerPoint.

3.1  INTRODUCTION

Microsoft PowerPoint is a software product of Microsoft office designed to assemble and display computer generated visual aids. Using this package one can make
computer-based presentations with animations, graphics and sound. Presentations with consistent style and colors can have better impact over audience. By stimulating the visual and sometimes auditory senses, you reach a larger audience and make more impact to enhance learning.

There are various examples where you require a presentation: conducting classes, introducing a product to sell, explaining an organizational structure, etc. Power point is a great tool for presenting new concepts, sharing information with students or parents, sharing pictures etc. It supports creation of animations, hyperlinks and insertion of sound and movies to make a powerful presentation. We shall learn about all of these features of MS-Power point in detail in this unit.

### 3.2 OPENING A POWER POINT

MS-Power point is one of the Ms-Office applications that can be opened in variety of ways from the Windows desktop. To open the power point package:

- Click **Start** button on your task bar.
- Select **Programs**.
- Select **Microsoft Office** and finally.
- Click on **Microsoft Office PowerPoint 2003**.

Steps are also illustrated through figure (Fig 3.1):

![Figure 3.1: To open Power Point](image-url)
After the click on Microsoft Office PowerPoint 2003 the main window would appear as shown in Figure 3.2. The window has many components: Title bar, Menu bar, Task pane and different buttons to view the presentation. It also shows screen slide layout templates. The detailed discussions on these components are followed in the next section.

![PowerPoint Window](image)

**Figure 3.2: Power point window**

### 3.3 ELEMENTS OF POWER POINT

The **PowerPoint Window** has toolbars and pane to help you quickly create presentations. Most of the toolbars are common in Office applications but some features are unique to PowerPoint. The following figure is the power point window showing all its elements:

![Elements of Powerpoint](image)

**Figure 3.3: Elements of Power point**
• Title Bar - displays the document name followed by a program name.
• Menu Bar - contains a list of options to manage and customize documents.
• Standard Toolbar - contains shortcut buttons for the most popular commands.
• Formatting Toolbar - contains buttons used for formatting.
• Status Bar - displays slide position and the type of design in PowerPoint.
• Drawing Toolbar - contains tools for drawing lines, shapes and objects.
• Help - provides quick access to Help topics.
• View Buttons/Icons and Slide Views

The view buttons at the left bottom corner of the screen allow three slide views: Normal View, Slide Sorter View and Slide Show.

The view buttons can be useful as you prepare your presentation. They control the way slides are displayed on the screen. Click a view button to see a different view.

Normal View: This view is generally used for preparing presentation. It provides the text outline of the entire presentation on the left, the current slide in the middle of the page, and a place to type in speaker notes at the bottom of the screen.

Slide Sorter View: Shows the entire set of slides (numbered) on the screen. In this view, you can drag and drop the slides to change their position.

Slide Show View: Displays the presentation in full screen mode starting with the slide that was last edited. You can press the Escape key to return to the Normal View and continue to work on your presentation.

• The Task Pane - The down-pointing arrow in the top, right corner of the pane allows you to select different menus and tools. By default, the Task Pane appears when PowerPoint is launched.

![Figure 3.4: Task pane](Image)
The **Slide Layout** and **Slide Design** panes within the Task Pane help organize layouts, design templates, and color schemes. When you select a design option, your slides are quickly updated with the new look. You can view the Slide Layout and Slide Design panes by clicking on the **down-pointing arrow** next to **New Presentation** in the Task Pane.

### 3.4 SAVING AND CLOSING A PRESENTATION

This feature allows you to store new or existing presentations on disk. If you do not save the file, you will be unable to view the presentation in the future. Once saved, you can re-open the file for viewing or editing.

To save a presentation file, follow the steps as:

From **File** menu, click **Save** as shown in the following figure:

![Figure 3.5: Saving file window 1](image1)

Now the following window appears:

![Figure 3.6: Saving file window 2](image2)
If it is a new file, the **Save As** dialog box appears. Ensure that you are located in the folder/disk drive of your choice by clicking the arrow to the right of the **Save in** drop down box and navigating to your required location.

- Enter the file name in the **File name** text box. The default file name is **Presentation1**; you can use it or type in a new file name.
- Let us say we key in **presentation1** for the file name, then click on the **Save** button to save. Now the presentation is saved.

**To close a presentation**

Follow the following steps to close a presentation file.

- From the **File** menu, click **Close**.

OR

- Click **Close Window** icon. As shown below:

OR

![Figure 3.7: Closing Power point file](image)

If unsaved changes have been made to your presentation the dialog box below is displayed, giving you the chance to save the presentation prior to closing.

![Figure 3.8: dialog box](image)

- Click **Yes** to save the presentation before closing OR click **No** to close without saving changes OR click on **Cancel** to cancel the operation.

**To exit Microsoft PowerPoint**

- Click on the **Close** icon displayed on the top-right corner of the screen.

After the introduction to the MS power point, we should proceed to the creation of our target presentation slides.
3.5 INSERTING TEXT

When you make a presentation, you are required to give a title to your presentation. Here in the Figure 3.9 we are using text to enter title.

To insert text into the slide click inside the boxes as shown below:

![Click to add title](image)

**Figure 3.9: To insert text**

Now, add title for example as the name of your village and your name (like Made by: Rajiv) as shown below:

![Village name: Rampur](image)

**Figure 3.10: Slide with Text**

To make the slide attractive we can use the available features of MS power point.
like selection of background, Slide Design, Slide layouts, Fonts, Animations, sound etc. which are discussed below.

3.6 SLIDE DESIGN

Now for our slide we can select the Slide Design templates by using the following steps:

- Right click on slide.
- Left click on the Slide Design.
- Then

on the right side you would see the list of Slide design templates.

Select one of the available designs for selection. Right click on that specific design and choose one of the available options. Here, we choose **Apply all the slides** option, as shown below.

![Figure 3.11: Applying slide design template](image)

3.7 ADDING A NEW SLIDE

Now to add one more slide to our presentation goto insert ® click New Slide or press keys **Ctrl+M** (as shown in the following Figure 3.12)

![Figure 3.12: Adding new slide](image)
Check Your Progress I

Note: a) Write your answer in the space provided.

b) Check your answer with the possible answer provided at the end of the unit.

1) What is a presentation? What are the advantages of giving presentation using PowerPoint?

..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................

2) Explain all the Elements of power point.

..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
..............................................................................................................................................
3.8 INSERTING CHART

After adding a new slide to our presentation, we will insert the population of your village in that blank slide. To show population we can use multiple tools available with MS power point package, as Tables, pie charts, text boxes, bar charts etc.

Suppose we add the following data of population of Rampur:

<table>
<thead>
<tr>
<th>Population</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>men</td>
<td>40</td>
</tr>
<tr>
<td>women</td>
<td>35</td>
</tr>
<tr>
<td>children</td>
<td>25</td>
</tr>
</tbody>
</table>

To show this data in our presentation perform the following steps:

- Go to File menu
- Click Insert Button
- Click Chart Button  (As shown below)

![Figure 3.13: Window for opening Chart](image)
The following window would appear:

![Chart window](image)

**Fig 3.14: Chart window**

Now, insert the data in the Datasheet as shown below in the figure:

![Datasheet](image)

**Figure 3.15: Inserting data into table**

After insertion of the above details, click anywhere in the slide then the following final slide would appear.
After completion of second slide we would use some more features in our next slide.

The next slide would present the status of schools and colleges available in the village. To show this information we would use some interesting features like ClipArt, WordArt, Tables and Animation in our next slide.

The idea is to put the information of schools and college of village in a tabular form so that the readability would be better than the normal textual form.

Let's add a new slide to the presentation as stated before.

### 3.9 WordArt

Word Art is a powerful component of Power Point. It gives ready made effects to your text so that a presentation can be made more attractive.

Following are the steps to insert Word Art:

- Go to **Menu Bar**.
- Click **Insert button**.
- Click **Picture button**.
- Click **WordArt button**.
In the Drawing Bar (at the bottom of the screen, look for a “blue A” that is slightly tilted (like the one on the right side). When you pass your cursor over this “button,” it will indicate: Insert WordArt.

If the Drawing Bar is not available, perform the following steps:

• Click-on View button in the Menu Bar.
• Click-on Toolbars button.
• Select Drawing button by clicking-on it.
• Click-on the Insert WordArt button. (As shown below in the Figure 3.18).
Now, the following **WordArt Gallery** menu screen will appear. Select one of the WordArt patterns by clicking on it. We choose one of them as indicated by the arrow shown in the following figure. Next, click on OK.

![WordArt Gallery](image)

**Figure 3.19: WordArt gallery**

The following **Edit WordArt Text** screen appears.

![Edit WordArt Text](image)

**Figure 3.20: Edit WordArt window (before inserting text)**

Now, where the window (Figure 3.20) indicates **Your Text Here**, replace this text with **Schools and Colleges**. Select a different font and size, if you desire, and then click **OK**. as shown in the following figure:
Basic Applications of Computers

Figure 3.21: Edit WordArt Text (after insertion of text)

Then the following slide appears

Figure 3.22: Slide with Word Art

Now, you may use the "grabbers" (little circles on the corners, as shown in the following Figure 3.23) to make the text larger/smaller. You may also move your text as you desire using mouse pointer.

Figure 3.23: Grabbers
If you want to change the “look” of your WordArt, it is possible to do so. You’ll need to display the **WordArt toolbar** as shown below:

![WordArt toolbar](image1)

**Figure 3.24: Word Art toolbar**

When you click on **OK** in **Edit Word Art Text window** (Figure 3.21), both **WordArt toolbar** and the WordArt appears as shown below (Figure 3.25):

![Slide with Word Art toolbar](image2)

**Figure 3.25: Slide with Word Art toolbar**

Let me explain about **WordArt Toolbar**: In the **WordArt Toolbar** the first two buttons are already familiar to you. A will allow you to **add another WordArt**. The **Edit Text** button will allow you to change the text in your **WordArt**.

If, for some reason, you move away from your WordArt by mistake, you’ll loose the **grabbers** as well as your WordArt toolbar. To “**activate**” both of them, simply place the cursor over the WordArt and click the left button on the **WordArt**. Both will re-appear.

After Adding Word Art, the slide would look like:
3.10 CLIP ART

The Microsoft PowerPoint contains drawings, photographs, sounds, videos, and other media files called as clips (clip: A single media file including art, sound, animation, or movies) that you can insert and use in presentations. These kinds of moving images are called animated images. You can insert an animated Clip Art image on any slide. After inserting an image you can move and size the image as you desire.

Now we would add an image to our slide with the help of Clipart. To add an image, follow the steps given below:

- Go to Insert.
- Click Picture button.
- Click Clip Art button.
Then the following window appears on the right side of power point screen.

![Clip Art window](image)

**Figure 3.28: Clip Art window**

Inside the **Search For**, type school and click **Go** button, the resultant images would appear as shown below:

![Adding Clip Art](image)

**Figure 3.29: Adding Clip Art**

Select an image that you would like to insert into your presentation; here we would insert the image, as shown in the Figure 3.29.

To insert an image first select an image, then right click on the image and finally click **Insert**; the image would be inserted into the slide. Now place the image at the desired position. Here we would place this image on right side of the title **Schools & colleges**. So the final Slide is as shown in the figure below:
3.11 INSERTING TABLES

After adding the image, we would add the information of Schools and colleges in the tabular form. To insert a table in the slide follow these steps:

- Go to menu.
- Click Insert button.
- Click Table button.

Then the following window appears:
Now insert the number of rows and columns, here we would insert 5 rows and 3 columns. Click ok. Then an empty table would appear inside your slide as shown in the figure below.

![Figure 3.33: Empty Table](image)

Add the details of different colleges and schools table; then the final slide would be as shown below:

<table>
<thead>
<tr>
<th>School/College</th>
<th>Standard up to</th>
<th>Run by</th>
</tr>
</thead>
<tbody>
<tr>
<td>Govt. primary school</td>
<td>Primary</td>
<td>Govt.</td>
</tr>
<tr>
<td>SBS public school</td>
<td>Sr. Secondary</td>
<td>Private</td>
</tr>
<tr>
<td>Vijay school of education</td>
<td>Post Graduation</td>
<td>Trust</td>
</tr>
<tr>
<td>CET College of Technology</td>
<td>B.Tech</td>
<td>Private</td>
</tr>
</tbody>
</table>

![Figure 3.34: Slide with table](image)

After completion of this slide, we would add one more slide where we would like to add some more text about our village. To proceed with this, first add one more slide as we did before.
Add the title “**My Village famous for:**“ with the help of **WordArt** as we did in our previous slides (Please refer to section 3.10.9).

Add the following text inside your slide with Bullets.

- Best Sugarcane farming in the District.
- Its special sweet “RASMALIE “.
- Its greenery and beautiful temples.
- Unity and integrity among communities.

After addition our slide would look like:

![My village famous for:](image)

- Best Sugarcane farming in the District.
- Its special sweet “RASMALIE “.
- Its greenery and beautiful temples.
- Unity and integrity among communities.

**Figure 3.35 : Slide with Bullets**

### 3.12 INSERTING ANIMATED IMAGES/MOVIES

To make it more attractive we would insert some animated images and movies. To add animated images or movies perform the following steps:

- Go to **Insert**.
- Click **Picture** button.
- Click **Clip Art** button.

![Figure 3.36: Steps to use animated images/movies](image)
After clicking the **ClipArt** button the following window image appears in the right side (Figure 3.37). Go to **Search for** text box and type words for which we would like to search the animated pictures/movies. While searching, make sure that only **Movies** is checked in.

![ClipArt Window](image)

**Figure 3.37:** Searching animated images/movies

Click **Go** button, then the search results would be displayed (Figure 3.38) and from these animated images select appropriate one and insert it as shown below:

![Inserting Animated Images](image)

**Figure 3.38:** Inserting animated images/movies
Follow the same searching and selection process for the words temple, sweets, integrity and unity. Now place them by dragging all these images at the right place. The final slide would appear like:

**My village famous for:**

- Best Sugarcane farming in the District.
- Its special sweet "RASMALIE".
- Its greenery and beautiful temples.
- Unity and integrity among communities.

Figure 3.39: Final Slide with animated images

It should be noted that the animated images would animate only at the play mode of slides.

Now we would add our last slide to end up our slide show. Here we would present a slide only with an animated movie/image with the help of Clipart with the search word “end”. The final slide would look like:

Figure 3.40: The final slide
3.13 SOME KEYBOARD SHORTCUTS

The MS Power Point supports several keyboards shortcuts:

**General**

- Open a Presentation: `<Ctrl> + <O>`
- Save a Presentation: `<Ctrl> + <S>`
- Print a Presentation: `<Ctrl> + <P>`
- Close a Presentation: `<Ctrl> + <W>`
- Undo: `<Ctrl> + <Z>`
- Redo or Repeat: `<Ctrl> + <Y>`
- New Slide: `<Ctrl> + <M>`
- Help: `<F1>`
- Switch between Applications: `<Alt> + <Tab>`

**Navigation—Go To:**

- The Previous Slide: `<Page Up>`
- The Next Slide: `<Page Down>`
- The First Slide: `<Ctrl> + <Home>`
- The Last Slide: `<Ctrl> + <End>`

**Slide Show Delivery**

(These shortcut keystrokes only work in Slide Show View)

- End Slide Show: `<Esc>`
- Display Specific Slide: `<Slide #> + <Enter>`
- Toggle Screen Black: `<B>`
- Toggle Screen White: `<W>`
- Pause Automatic Show: `<S>`
- Show/Hide Pointer: `<A>`
- Change Arrow to Pen: `<Ctrl> + <P>`
- Change Pen to Arrow: `<Ctrl> + <A>`
- Erase Screen Doodles: `<E>`

**Editing**

- Cut: `<Ctrl> + <X>`
- Copy: `<Ctrl> + <C>`
Basic Applications of Computers

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste</td>
<td>&lt;Ctrl&gt; + &lt;V&gt;</td>
</tr>
<tr>
<td>Find</td>
<td>&lt;Ctrl&gt; + &lt;F&gt;</td>
</tr>
<tr>
<td>Replace</td>
<td>&lt;Ctrl&gt; + &lt;H&gt;</td>
</tr>
<tr>
<td>Select All</td>
<td>&lt;Ctrl&gt; + &lt;A&gt;</td>
</tr>
<tr>
<td>Duplicate</td>
<td>&lt;Ctrl&gt; + &lt;D&gt;</td>
</tr>
</tbody>
</table>

**Formatting**

<table>
<thead>
<tr>
<th>Style</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>&lt;Ctrl&gt; + &lt;B&gt;</td>
</tr>
<tr>
<td>Italic</td>
<td>&lt;Ctrl&gt; + &lt;I&gt;</td>
</tr>
<tr>
<td>Underline</td>
<td>&lt;Ctrl&gt; + &lt;U&gt;</td>
</tr>
</tbody>
</table>

**Check Your Progress II**

**Note:**

a) Write your answer in the space provided.

b) Check your answer with the possible answer provided at the end of the unit.

1) Write down the steps to insert Word Art to presentation.

....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................

2) What is the use of animation in a presentation? Write down the steps to insert an animation into a presentation.

....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................
Basic Applications of Computers

Paste  <Ctrl>+<V>
Find  <Ctrl>+<F>
Replace  <Ctrl>+<H>
Select All  <Ctrl>+<A>
Duplicate  <Ctrl>+<D>

Formatting
Bold  <Ctrl>+<B>
Italic  <Ctrl>+<I>
Underline  <Ctrl>+<U>

Check Your Progress II

Note: a) Write your answer in the space provided.
   b) Check your answer with the possible answer provided at the end of the unit.

1) Write down the steps to insert Word Art to presentation.

.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................

2) What is the use of animation in a presentation? Write down the steps to insert an animation into a presentation.

.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
.....................................................................................................................
3.14 LET US SUM UP

Let us recapitulate what we have learnt so far in this unit:

- Microsoft Power Point is a Windows-based presentation package.
- Working with Power Point is possible by using the keyboard, mouse, or the scroll bars.
- Insertion of Images, Text, Sound can be done.
- Saving a Presentation saves all the text, images, animation etc contained in it.
- Power Point presentations can be stored, renamed, and deletion is also permitted.
- WordArt feature lets you change the appearance of Text.
- Charts of different kinds can be inserted into your presentation by using the chart wizard.
- You can give print command through print option in File menu. You can print all slides as well as selected slide of a particular presentation.
- ClipArt feature lets you insert the images and you can animate them as per requirement.
- Insertion of Tables let you to add/show information in tabular form.
- Keyboard shortcuts lets you to work faster with PowerPoint.

3.15 REFERENCES AND SUGGESTED READINGS

- SAMS teach yourself Microsoft Office PowerPoint 2003 in 24 hours By Tom Bunzel
3.16 CHECK YOUR PROGRESS - POSSIBLE SOLUTIONS/ANSWERS

Check Your Progress I

1) Presentation is a kind of communication between the speaker and the audience. There are various circumstances in which a presentation is made: teaching a class, introducing a product to sell, explaining an organizational structure, etc. PowerPoint is a great tool for presenting new concepts, sharing information with students or parents, presenting a daily agenda board, sharing pictures. It supports creation of animations, hyperlinks and insertion of sound and movies.

Advantages of presentation using PowerPoint

Microsoft PowerPoint is a software product of Microsoft office designed to assemble and display computer generated visual aids. Using this package one can make computer-based presentations using animations, graphics and sound. Presentations with consistent style and colors can have better impact over audience. By stimulating the visual and sometimes auditory senses, you reach a larger audience and make more impact to enhance learning.

2) Components of PowerPoint

- **Title Bar** - displays the document name followed by a program name.
- **Menu Bar** - contains a list of options to manage and customize documents.
- **Standard Toolbar** - contains shortcut buttons for the most popular commands.
- **Formatting Toolbar** - contains buttons used for formatting.
- **Status Bar** - displays slide position and the type of design in PowerPoint.
- **Drawing Toolbar** - contains tools for drawing lines, shapes and objects.
- **Help** - provides quick access to Help topics.
- **View Buttons/Icons and Slide Views.**
  - The **view buttons** at the left bottom corner of the screen allow three slide views: **Normal View, Slide Sorter View** and **Slide Show**.

The view buttons can be useful as you prepare your presentation. They control the way slides are displayed on the screen. Click a view button to see a different view.

**Normal View:** This is the view that you will use to work on your presentation. It provides the text outline of the entire presentation on the left, the current slide in the middle of the page, and a place to type in speaker notes at the bottom of the screen.

**Slide Sorter View:** Shows the entire set of slides (numbered) on the screen. In this view, you can drag and drop the slides to change their position.

**Slide Show View:** Displays the presentation in full screen mode starting with the
slide that was last edited. Press the Escape key to return to the Normal View and continue to work on your presentation.

Check Your Progress II

1) Following are the steps to insert Word Art

- Go to Menu Bar.
- Click Insert button.
- Click Picture button.
- Click WordArt button.

Another way to open Word Art is as follows:

In the Drawing Bar (at the bottom of the screen), look for a “blue A” that is slightly tilted. When you pass your cursor over this “button,” it will indicate: Insert WordArt. If the Drawing Bar is not available, click on View in the Menu Bar, then click on Toolbars and select Drawing by clicking on it. Click on the Insert WordArt button. The WordArt Gallery menu screen will appear. Select one of the WordArt patterns by clicking on it. Next, click on OK.

2) Animation is used to make presentation more attractive and understandable. To make it more attractive we would insert some animated images that resembles with our tags. To add animated images or movies follow the steps:

- Go to Menu
- Click Insert button
- Click Picture button
- Click Clip Art

After this, a Clip Art pane appears in the right side. Go to Search for text box and type words for which we would like to search the animated pictures/movies. While searching, it should be making sure that only Movies should be checked in.

Search results would be displayed and from that resulted animated images select appropriate one and insert it using right click on that selected image. Then press button ‘insert’.

It should be noted that the animated images would animate only at the play mode of slides.

Lab Exercise:

Note:  
a) Write your answer in space provided at the end of this unit.

b) For practical purpose attend practical lab.

1) Prepare a power point presentation about your village using the following information:

a. A slide showing the name and location of your village.

b. The next slide should show the features of your village like village is famous for its greenery, rivers, jungles, animals etc.
Basic Applications of Computers

c. In the next slides add the information of the villagers (in tabular form and make use of the charts also) about their educational qualifications like Male/Female literacy rate in numbers, no. of animals including their types etc.

d. Add suitable images to the above slide like animals, people etc.

e. Add some sound (if available) to your slides.

Space provided for practical work
## BPR-005: Basic Computer Literacy

<table>
<thead>
<tr>
<th>Block 1</th>
<th>Basics of Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit 1</td>
<td>Introduction to Computers</td>
</tr>
<tr>
<td>Unit 2</td>
<td>Network</td>
</tr>
<tr>
<td>Unit 3</td>
<td>Operating System</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Block 2</th>
<th>Basic Applications of Computers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit 1</td>
<td>Introduction to MS-Word</td>
</tr>
<tr>
<td>Unit 2</td>
<td>Introduction to MS-Excel</td>
</tr>
<tr>
<td>Unit 3</td>
<td>Power Point Presentation</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Block 3</th>
<th>Further Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit 1</td>
<td>Internet Overview</td>
</tr>
<tr>
<td>Unit 2</td>
<td>Pay Roll</td>
</tr>
<tr>
<td>Unit 3</td>
<td>Accounts</td>
</tr>
</tbody>
</table>
About the Project

IGNOU through the Ministry of Panchayati Raj and under the sponsorship of United Nations Development Programme (UNDP) undertook a project on 'Capacity Building of PRIs Through a Multi-Mode Training Intervention' as an attempt at empowering and capacity building of elected members of Panchayats and development functionaries. It also aimed at institutionalizing mechanisms to strengthen this capacity building intervention. The Project covered six northern states including Bihar, Haryana, Madhya Pradesh, Rajasthan, Chhattisgarh and Uttarakhand with the Indira Gandhi National Open University (IGNOU) as the implementing agency. The Project envisaged joint action by Government established institutions (SIRDs) and NGOs engaged in Capacity Building of PRIs.

In terms of strategy it involved developing a suitable learning package through a balanced mix of distance learning and conventional training; adapting the materials to local requirements and implementing the capacity building intervention through distance mode for the elected members of Panchayats and train associated development functionaries through face to face mode through a network of SIRDs and NGOs.

In terms of activities and output of the Project, the Project has been able to prepare a multi-media package consisting of 11 self-learning booklets and six video programmes for distribution among the Panchayats; undertook capacity building of Collaborating Institutions (CIs); published of local Governance updates in each participating state; conducted BDOs Symposia and orientation programmes for development functionaries. One of the major activities taken up by the above CIs was to undertake hardware mapping of Panchayats in 4 Districts in each participating State. The Diploma in Panchayat Level Administration and Development, planned and developed as a part of academic activities of the School of Continuing Education, was also sponsored under the above Project.
About IGNOU & SOCE

The Indira Gandhi National Open University, established by an Act of Parliament in 1985, has emerged as the largest Mega University in the democratic world. The University offers 486 Certificates, Diploma, Degree and Doctoral programmes through its 21 schools of Study, 12 Divisions, 14 Centres, 61 Regional Centres, over 3,000 Study Centres, 67 Partner Institutions spread across 35 countries. Additional help is also sought from about 6,000 experts from conventional universities and other organizations, and about 45,000 part-time academic counselors.

IGNOU caters to learners from rural and tribal areas, disability groups, jails and rehabilitation centres, government and non-governmental organizations, parents and home-makers, the employers and the employed.

One of the mandates of the University is to reach out to the disadvantaged by offering programmes in all parts of the country at affordable cost. IGNOU, the National Resource Centre for Open and Distance Learning with international recognition and presence, is expected to provide seamless access to sustainable and learner centric quality education, skill upgradation and training to all by using innovative technologies and methodologies and ensuring convergence of existing systems for massive human resource required for promoting integrated national development and global understanding.

The School of Continuing Education (SOCE) one of the oldest Schools currently has four disciplines assigned to it by the Academic Council. These include: Rural Development, Nutritional Sciences, Child Development and; Home Science. The School has currently on offer Ph.D programmes in three discipline areas, two Master's Degree level programmes, one Post Graduate Diploma, two Diploma Programmes, four Certificate Programmes and four elective and application oriented courses in the above mentioned disciplines.